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1 How to use this guide 
The OrbusInfinity Installation Guide contains reference on how OrbusInfinity interacts with 
your environment and installation instructions to prepare for OrbusInfinity integration to 
your systems. 

This guide is intended for Project Lead, SharePoint Site Collection Administrator, Office 365 
Administrator, and Azure AD Administrator. 

Tips, information of special importance, and information that may apply only in special 
cases can be found in Note . Information that is essential to the completion of a task or 
to access the feature can be found in Important Note . 

2 Reference materials 
As OrbusInfinity is tightly integrated with Microsoft products, we recommend to get 
acquainted with available guides and training on Office products: 

 Microsoft 365 help and training 

 Visio help center 

 Word help center 

 Excel help center 

 SharePoint help center 
  

https://support.office.com/
https://support.office.com/en-us/visio
https://support.microsoft.com/en-us/word
https://support.office.com/en-us/excel
https://support.office.com/en-us/sharepoint
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3 Application interaction overview 
OrbusInfinity is a cloud-based application that provides seamless integration with your 
existing Microsoft 365 application suite and Azure Active Directory using the following 
integration points: 

  

 OrbusInfinity Visio Add-In  To provide a modeling environment that 
synchronizes data with the OrbusInfinity 
repository. 

 OrbusInfinity Export Tool To enable the export of data from the 
OrbusInfinity repository into a Word document. 

 OrbusInfinity Import Tool To enable the import of data into OrbusInfinity 
from the Excel desktop. 

 Modern Web Browsers To use the OrbusInfinity application portal for 
repository management. 

 Azure Active Directory 
Enterprise Applications 

To authenticate users, request Tokens, and 
enable user and group management in 
OrbusInfinity. 

 Other third-party applications Business tools that you can integrate with the 
Solutions Hub to realize key use cases. 
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 OrbusInfinity Export Tool To enable the export of data from the 
OrbusInfinity repository into an online Word 
document. 

 OrbusInfinity Import Tool To enable the import of data into OrbusInfinity 
from your Excel files stored in the cloud. 

 SharePoint 365 Applications To provide OrbusInfinity functionality via web 
parts, enhanced Visio Online document viewing, 
and to enable interaction with documents 
without the need to store them in OrbusInfinity. 

3.1 Authentication 
OrbusInfinity operates with Microsoft Azure technologies to best integrate into Microsoft 365 
and your existing Azure infrastructure.  

OrbusInfinity uses the OAuth 2.0 protocol to authenticate users against your existing Active 
Directory to confirm that they are indeed valid and to allow OrbusInfinity to access 
resources on their behalf. This means that the management of user access can remain in 
the control of your Azure AD administrators.  

Also, users can access OrbusInfinity using their existing Microsoft 365 accounts. This 
removes the need for extra user accounts specific to OrbusInfinity itself.  

Any controls and security measures that you have applied to your Active Directory will 
apply to access OrbusInfinity, such as Two-Factor Authentication. 

The application uses the implicit grant flow.  

 

  

https://learn.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-implicit-grant-flow


OrbusInfinity Installation Guide 

8 

 

 

4 Prerequisites and requirements 
For smooth installation of OrbusInfinity, complete all of the below requirements first: 

 Application requirements – Set up access to OrbusInfinity web application and 
Office Add-ins 

 Microsoft 365 and Azure requirements – Configure necessary integrations and 
access permissions 

4.1 Application requirements 
The following are required to access the OrbusInfinity web application and use the ancillary 
Office Add-ins for performing tasks such as Visio diagram creation, data export to Word, 
and Excel data import. 

Desktop browsers 
The OrbusInfinity application is a web application that is fully responsive on the following 
desktop browsers: 

 Google Chrome (latest) 

 Microsoft Edge (Chromium, latest)  
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Visio Add-in 

 
Important 
Target audience of the below requirements is your organization’s Desktop Team. 

 

 

Important 
You can experience unexpected behavior with the Visio Add-in if the most recent 
Windows updates are not installed. Ensure that your PC is fully up to date. 

The OrbusInfinity Visio Add-in is an embedded Visio solution with custom commands and 
features to visualize your repository data on diagrams. 

 
Download Visio Add-in MSI installer 

To be able to install Visio Add-in, you need to have the below in place. 

Requirement Description 
MSI installer 
downloaded  

 Visio Add-in requires installing locally on users' machine via 
an MSI installer. Download this from your OrbusInfinity web 
application (see the screenshot above). 

 If your organization has blocked the ability to install 
applications on user machines, the Visio Add-in will require 
central distribution by your system administrator.  

Supported Visio version  Visio 2013 (v15.0; Professional) 
 Visio 2016 (v16.0; Professional, Office 365) 
 Visio Online Plan 2 (Desktop, Office 365) 
 Visio 2019 (v16.0; Professional) 
 Visio 2021 (Professional) 
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Requirement Description 
To obtain Microsoft 365 application's version number, select 
File > Account. In the lower-right corner of the window in the 
About panel, the current value is specified. 

.NET Framework v4.8 Verify you have this version of software or higher installed to be 
able to use the Add-in. 

Visual Studio 2010 Tools 
for Office Runtime 
installed 

To run the Visio Add-in, you need Visual Studio 2010 Tools for 
Office Runtime installed. You can download the latest version 
from the Microsoft Download Center. 

Your OrbusInfinity 
environment added to 
the Allow List  

OrbusInfinity doesn’t support proxy authentication at the 
moment. If you use a proxy server that requires authentication, 
add your company’s OrbusInfinity environment URL to your 
organization’s Allow List for the Visio Add-in to communicate 
with OrbusInfinity. 

Export and Import Tools 

 

Important 
Target audience of the below requirements is your organization’s Office 365 Admin 
Team. 

The OrbusInfinity Export Tool (or Word Add-in) allows to insert OrbusInfinity data into 
Microsoft Word documents. With the OrbusInfinity Import Tool (or Excel Add-in), you can 
bulk import—create and update—data to OrbusInfinity, using the same file.  

  

https://www.microsoft.com/en-GB/download/details.aspx?id=48217
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To integrate the tools with OrbusInfinity, review the below: 

Requirement Description 
Supported versions  Online clients (included as part of Microsoft 365 

subscriptions) 
 365 Edition 64bit or 32bit 
 Office 2016 Professional Plus Edition (v. 16.0.8067) 

Add-ins access policy Export Tool and Import Tool are supplied via the Office Add-in 
interface and do not require a traditional installer. The add-
ins are added to your Office Add-in Store for users with the 
correct Microsoft 365 licenses to access them in both Online 
and supported Desktop clients.  
If your organization blocked access to Office Add-in, refer to 
the Centralized Deployment requirements below. 

Configure Centralized 
Deployment 
requirements 

You need to deploy Office Add-ins to users and groups within 
your organization. For this, you need to make sure Centralized 
Deployment requirements are properly configured in your 
tenant.  
We recommend that your system administrator follows the 
Microsoft guidelines to confirm the compatibility with this 
deployment approach. 

Access the Add-ins 
online 

If you want to use the add-ins online too—via Word or Excel 
Online clients, ensure to have a Microsoft 365 license that 
grants access to Microsoft 365 Online. 

4.2 Microsoft 365 and Azure requirements 
In scope of Microsoft 365 and Azure requirements set, you need to configure below: 

 SharePoint Online to set up one of the major OrbusInfinity integrations 

 Azure AD Enterprise App to configure permissions for OrbusInfinity web application and 
Solutions Hub  

 Orbus Professional Services access to get ready your OrbusInfinity environment 

 OrbusInfinity Knowledge Base access setup to enable users’ access to the Knowledge 
Base 

  

https://docs.microsoft.com/en-gb/microsoft-365/admin/manage/centralized-deployment-of-add-ins?redirectSourcePath=%252fen-us%252farticle%252fdetermine-if-centralized-deployment-of-add-ins-works-for-your-office-365-organization-b4527d49-4073-4b43-8274-31b7a3166f92&view=o365-worldwide
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SharePoint Online  

 

Important 
To complete the below requirements, you need to be assigned administrator rights 
in your SharePoint tenant. 

SharePoint is one of the OrbusInfinity integration points where you store documents and 
collaborate with colleagues on repository data. It facilitates the collection and update of 
data and makes it accessible for contributors across your organization. 

To set up SharePoint integration with your OrbusInfinity repository, consider the below 
requirements. 

Requirement Description Purpose 
Create a dedicated 
SharePoint Online Site 
Collection within your 
SharePoint Online 
Tenant 

 This site must use the 
Communication Site 
template. 

 Make sure to add the 
iServer string to the 
SharePoint Online Site 
Collection’s description or 
URL, for the Solutions Hub 
to identify your site 
collection correctly. 

You and people in your 
organization will use this Site 
Collection to publish and view 
documents, topics, events, and 
projects. 
With the SharePoint Online Site 
Collection, you will be able to 
reach out to data contributors 
and keep your data up-to-date, 
using convenient methods. 

Create an App 
Catalog  

Scope an App Catalog to the 
SharePoint Online Site 
Collection. 

An App Catalog holds all 
OrbusInfinity SharePoint apps in a 
single space. You must have it in 
place for the SharePoint Tenant 
administrators to manage 
permissions and usage of the 
applications and update when 
new features are released.  

Install OrbusInfinity 
SharePoint Connector 
App  

This application provides Full 
Control to the SharePoint 
Online Site Collection to which 
OrbusInfinity will be linked. 

Connector App enables 
integration between OrbusInfinity 
and SharePoint. 
It also allows to install, maintain, 
and update SharePoint web 
parts and extensions. 

 

  

https://docs.orbussoftware.com/articles/get-started-with-collective-contribution
https://docs.orbussoftware.com/articles/work-with-sharepoint-web-parts
https://docs.orbussoftware.com/articles/work-with-sharepoint-web-parts


OrbusInfinity Installation Guide 

13 

 

 

Azure AD Enterprise App 

 

Important 
Target audience of the below requirements is your organization’s Azure AD 
administrator. 

OrbusInfinity uses enterprise application in your Azure AD tenant to authenticate users and 
to request access to Microsoft 365 resources.  

Permission request type Description 

Application Permissions Enables the OrbusInfinity Azure AD Enterprise App to perform 
actions within the scope of the applied permissions set 
requested by our App. These are granted by your Azure AD 
Administrator at the point of installation. 

Delegated Permissions Enables the OrbusInfinity Azure AD Enterprise App to perform 
actions within the scope of the currently logged in user's 
permissions set, on their behalf. 

You need to grant different sets of permissions for the two below enterprise applications: 

 OrbusInfinity web application 

 Solutions Hub 
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4.2.1.1 OrbusInfinity 

The following permission sets are requested by the OrbusInfinity enterprise application in 
Azure AD tenant. 

Permission request type Permissions Description 
Office 365 SharePoint 
Online: Delegated 
Permissions 

Read items in all 
site collections 

The requested permission is a 
delegated permission, which 
means that OrbusInfinity will access 
SharePoint on behalf of the logged-
in user and at most can only 
access entities that the logged-in 
user has access to. 
To ensure that OrbusInfinity only 
accesses documents within the 
configured OrbusInfinity SharePoint 
Site Collection, all SharePoint 
access is governed to go through 
an Orbus internal service which 
guarantees that any access is 
solely limited to the configured 
OrbusInfinity site collection. 

Microsoft Graph: 
Application Permissions 
(optional) 

 Read all users' 
full profiles 

 Read group 
memberships 

These enable your designated 
OrbusInfinity Administrator to 
import users and groups from your 
Azure AD into the application. These 
are only requested if not using the 
Azure AD user provisioning 
functionality. 

4.2.1.2 Solutions Hub 

The following permission sets are requested by the Solutions Hub enterprise application in 
Azure AD tenant. 

 Note 

You need to enable the below permissions only if you use integration with the 
Solutions Hub.  

 

Permissions type Permissions Description 
Microsoft Teams: 
Delegated 
Permissions  
 

 Read the names and 
descriptions of teams  

 Read the names and 
descriptions of channels 

 Read users' relevant 
people lists 

These enable Solutions Hub users 
to read the names and 
descriptions of teams and 
channels, on behalf of signed-in 
user and allows the app to read a 
scored list of people relevant to the 
signed-in user. The list can include 
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Permissions type Permissions Description 
local contacts, contacts from social 
networking or your organization's 
directory, and people from recent 
communications (such as email 
and Skype).  

Microsoft Project 
Online and 
SharePoint: 
Delegated 
Permissions  

Read items in all site 
collections 

This enables Solutions Hub to track 
documents and list items in all site 
collections on behalf of the signed-
in user. It’s scoped to ensure user-
specific document permissions 
within Project Online and SharePoint 
are upheld. 

Microsoft Planner: 
Delegated 
Permissions  

Read user’s tasks and task 
lists (preview) 

This enables Solutions Hub to read 
the signed-in user’s tasks and task 
lists, including any shared with the 
user. Doesn't include permission to 
create, delete, or update anything. 

Orbus Professional Services access 

 

Important 
To complete the below requirements, you need to be assigned administrator rights 
in Azure AD and SharePoint. 

To set up and customize your OrbusInfinity environment, provide an Orbus Professional 
Services Consultant with access to:  

 your OrbusInfinity environment, with the administrative role 

 OrbusInfinity SharePoint site, with the Site owner role 

OrbusInfinity and SharePoint use Azure AD for authentication/authorization. Because of this 
the Consultant will either need a guest account or an organizational account in your Azure 
AD tenant. 

 Guest account 

A guest account is an external account that, on behalf of a guest, accesses specific 
resources in your Azure AD tenant. 
To add a guest account, an Azure AD Administrator should send an invitation to the 
Consultant. Then, the Consultant will be able to access your Azure AD tenant resources 
with their Orbus Software Azure AD account. 

 
Note 
SharePoint permissions may block guest accounts’ access to SharePoint 
sites. Check with your SharePoint admin if external sharing to guest accounts 
is blocked on your SharePoint tenant. If so, set up an organizational account 
for the Consultant. 
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 Organizational account 

An organizational account is the same type of account that the users in your 
organization have. To set up an organizational account, create an Azure AD account for 
the Consultant as if they are a member of your organization. 

 
Note 
Your organization may have an application or approval process to create an 
organizational account.  
Consult your Azure AD Admin to decide what option is best for your 
organization. 

Regardless of the account type set up for the Consultant: 

1. In Azure AD, assign the Consultant the administrator role in OrbusInfinity enterprise 
application created during the post-installation call with an Orbus Software Support 
team member. 

2. On SharePoint site used for OrbusInfinity, grant the Consultant with the Site Owner 
permissions for the SharePoint site used for OrbusInfinity. 

OrbusInfinity Knowledge Base access setup 

 

Important 
To complete the below requirements, you need to be assigned administrator or 
global administrator rights in Azure AD. 

For your users to access the KB, some Azure AD permissions must be granted to the KB by 
each user. 

With default Azure AD settings, the required permissions do not require Admin consent and 
users are able to approve the permissions themselves when first logging in to the KB. 

You may however choose to do the permission grant on behalf of all your users, thereby 
preventing users from having to go through this process. Alternatively, your Azure AD 
settings may have been modified to prevent users approving apps themselves, in which 
case you will need to do this on their behalf. 

  



OrbusInfinity Installation Guide 

17 

 

 

To carry out the permission grant for all of your users: 

1. Go to the Knowledge Base and log in using an account with Azure AD Global 
Administrator rights. 

2. Review and grant the permissions. 

 

5 Installation overview 
There are four key stages to provision an OrbusInfinity instance and integrate it with your 
Microsoft 365 environment which must occur sequentially: 

1. Customer environment setup 

Usually, SharePoint Administrator and Azure AD Global Administrator prepare your 
SharePoint site with which OrbusInfinity will interact, and install the SharePoint 
Connector App. 

2. OrbusInfinity site provisioning 

After receiving all prerequisite information from your Administrators our support 
engineers create an OrbusInfinity instance that is configured to work with your users 
and integrate into your Microsoft 365. 

  

https://docs.orbussoftware.com/
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3. Permission grants and Add-ins setup 

Azure AD Global Administrator with guidance from our support engineers enables 
the OrbusInfinity access to the required Azure AD permissions on your environment and 
the deployment of Visio and Excel Add-ins. These steps can be completed in less than 
thirty minutes offline or during a call with our engineers. 

4. Solutions Hub installation 

Solutions Hub is a cloud platform that provides Solutions to business challenges related 
to common enterprise transformation. It presents a catalog of ready-made Solutions to 
provide outcomes for various enterprise architecture and transformation use cases, 
systems, and roles. 

6 Customer environment setup 
This section describes the steps required by your Microsoft 365 and Azure AD 
Administration Team to prepare your environment for the OrbusInfinity application 
interaction: 

 SharePoint site setup 

 SharePoint Connector App installation 

 
Note 
Once you complete the instructions in the next section, our engineers will proceed 
with the creation of an OrbusInfinity instance. Ensure to gather all the required 
information in the end of the section and send it to your Orbus account manager or 
technical contact. 

6.1 SharePoint site setup 

 
Important 
To perform the following procedure, you must be a SharePoint Administrator. 

 

 
Note 
To create the Site Collection App Catalog, it’s required that your SharePoint site 
contains a Tenant App Catalog. For more details on how to set up the Tenant App 
Catalog, go to Microsoft SharePoint documentation. 

1. Create a new SharePoint Site Collection using the Communication Site Modern 
template. 

2. Create an App Catalog scoped to the Site Collection: 

a. Download and install the SharePoint Management Shell cmdlets from Microsoft. 
You must have SharePoint Administrator permission, which can be assigned via 
Azure Portal (Azure Active Directory > User > Directory role). 

  

https://docs.microsoft.com/en-us/sharepoint/use-app-catalog
https://www.microsoft.com/en-gb/download/details.aspx?id=35588
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b. Open a PowerShell window and run the following commands: 
Connect-SPOService -Url "SharePoint Admin Site URL" 

Add-SPOSiteCollectionAppCatalog -Site "SharePoint OrbusInfinity  

Site URL" 

Where SharePoint Admin Site URL is the URL of the Microsoft 365 SharePoint Admin 
Centre that you have accessed during the SharePoint Site Collection creation. This 
URL is usually the SharePoint instance name with -admin appended. 

For example, if the SharePoint instance URL is https://contoso.SharePoint.com/, 
SharePoint Admin Site URL would be https://contoso-admin.SharePoint.com/. 

SharePoint OrbusInfinity Site URL is the URL of the SharePoint site that you created, 
for example https://contoso.SharePoint.com/sites/OrbusInfinity. 

You can view a new “Apps for SharePoint” container in the Site Contents of the Site 
Collection. 

 
3. Enable external site sharing for the newly created SharePoint site, so Orbus Professional 

Services Consultants can access it. For more information, see this Microsoft guide.  

 
Note 
Make sure to add Orbus Consultants as Site Owner of the newly created SharePoint 
site, so they are able to upload content and carry out configuration. 

6.2 SharePoint Connector App installation 

 

Important 
To complete the below requirements, you need to be assigned administrator rights 
in your SharePoint tenant. 

To enable integration between OrbusInfinity and SharePoint, install the SharePoint 
Connector App to the SharePoint site App Catalog. This also allows OrbusInfinity to install, 
maintain, and update its SharePoint web parts and extensions. To install the SharePoint 
Connector App: 

1. Download the app at https://static.iServer365.com/sharepoint-
connector/prod/iServer365.SharePointConnector.app. 

2. Open Site Collection, created in the SharePoint Site Setup section earlier. For example, 
https://contoso.SharePoint.com/sites/OrbusInfinity. 

https://contoso-admin.sharepoint.com/
https://docs.microsoft.com/en-us/sharepoint/external-sharing-overview
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3. Open the Site App Catalog: 

a. In the upper-right corner, select Settings > Site Contents. 

 

b. Select Apps for SharePoint. 

 
4. Upload the app, downloaded in Step 1, to the Site App Catalog. 

 

 
Important 
Ensure you upload the app to the Site Collection App Catalog – not Tenant App 
Catalog. 

5. Install the app to the Site: 

a. Open the SharePoint Site and in the upper-right corner, select Settings > Add an 
app. 
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b. In the search box, type iServer365 Connector and select the app. 

 
c. In the dialog box that opens, review the permissions and select Trust it. 
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7 OrbusInfinity site provisioning 

 
Important 
Target audience of the below requirements is your organization’s Project Lead. 

To enable OrbusInfinity support engineers to create an application instance integrated to 
your Microsoft 365 environment, collect the following information and send it to your Orbus 
account manager: 

 Azure Tenant ID 

 Azure Tenant Name 

 URL of the SharePoint site OrbusInfinity will integrate with 

 Confirmation that the SharePoint Connector App has been deployed  

 Whether you have an Azure Active Directory Premium P1 or P2 license 

This determines the ability to use Azure AD user provisioning for user management in 
Azure AD. This lowers the permission demands of the application and is the preferred 
approach to user management. 

 Confirmation of Azure AD Guest User Accounts for Orbus Consultants  
If you can’t assign Guest users to Orbus Consultants, then we need temporary users in 
your Azure AD instead and the following information: 

 Azure AD ID 

 Username 

 Temporary Passwords 

Your account manager passes this information to the Orbus Support Engineer responsible 
for your installation so that they can proceed with creating an OrbusInfinity instance. 
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8 Permission grants and Add-in setup 

 

Important 
To complete the below requirements, you need to be assigned administrator or 
global administrator rights in Azure AD. 

To complete this stage of the installation, Orbus Support Engineers contact you to: 

 Grant Azure AD permissions for OrbusInfinity 

 Configure User Provisioning 

 Turn off Assignment required? option 

 Install the Import Tool (Excel Add-in) and Export Tool (Word Add-in) 

This section describes the process of permission grants and Add-ins setup steps; however, 
we can also offer this via an installation call if required. 

8.1 Azure AD permissions 

 
Important 
To perform the following procedure, you must be an Azure AD Global Administrator. 

To enable interaction with your Microsoft 365 environment, Orbus Support Engineers direct 
the Global Administrator to the OrbusInfinity login page where the permission grant is 
complete: 

1. Open OrbusInfinity, and on the login page, enter the Global Administrator credentials. 

 

  



OrbusInfinity Installation Guide 

24 

 

 

2. Review and grant permissions. 

 

 
Note 
The bottom two permissions, Read group memberships and Read all users’ full 
profiles, are optional and might not be listed in this window. 
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8.2 User provisioning 

 

Important 
To complete the below requirements, you need to be assigned administrator or 
global administrator rights in Azure AD. 

Azure User Provisioning uses SCIM—an industry-wide standard for managing user identities 
in cloud-based applications. 

Configure user provisioning 

 
Note 
To perform the following procedure, you must be an Azure AD Global Administrator 
and have an Azure AD Premium P1 or P2 license. 

1. In the Azure Portal, on the Azure Active Directory Enterprise Application blade, 
select New application. Alternatively, select the following link to go to the correct 
location: 
https://portal.azure.com/#blade/Microsoft_AAD_IAM/AppGalleryApplicationsBlade/cat
egory/topapps 

2. Under Add your own app, select Non-gallery application and enter a name for the new 
application and select Add. 

Orbus recommends using iServer365 – User Provisioning as the application’s name. 

 
  

https://portal.azure.com/#blade/Microsoft_AAD_IAM/AppGalleryApplicationsBlade/category/topapps
https://portal.azure.com/#blade/Microsoft_AAD_IAM/AppGalleryApplicationsBlade/category/topapps
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3. When the application is created, in the Provisioning section, select Get started. 

 
4. To view additional fields, in the Provisioning Mode list, select Automatic. 

5. Under Admin Credentials, in the Tenant URL and Secret Token fields, enter details 
provided by Orbus and select Test Connection. 
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6. After the test is run successfully, on the toolbar, select Save. 

7. Under Mappings, select Provision Azure Active Directory Users. 

 
8. In the Attribute Mapping window, select the mailNickname attribute that is 

set to externalId. 
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9. In the Edit Attribute dialog box, in the Source attribute list, select objectId, and select 
OK. 

 
10. To save attribute mappings, on the toolbar, select Save. 

11. Set the Provisioning Status to On, and on the toolbar, select Save. 

 
Azure AD is now ready to provision users into OrbusInfinity. 

  

https://docs.orbussoftware.com/articles/manage-users#Provision_Users_into_iServer365
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Manage OrbusInfinity users 
After you configured the user provisioning, you can add users to OrbusInfinity. To do this, 
open the enterprise application created in the previous procedure (Configure user 
provisioning) and in Users and groups section, add or remove users and groups.  

The changes are then synchronized over to OrbusInfinity by the Azure Active Directory 
provisioning engine. 

 

Note 
The synchronization engine runs on a schedule and changes can take up to 40 
minutes to synchronize across to OrbusInfinity. 

8.3 Turn off Assignment required option 
For applications created in Azure AD the Assignment required? option defines whether all 
users (both members and guests) and apps or services can access them. By default, this 
option is set to No which we recommend not to change. 

For security reasons, some customers set the option to Yes which might cause unexpected 
issues. Among others, preventing connected applications, such as Solutions Hub, from 
authenticating in to OrbusInfinity.  

Therefore, this is highly recommended to keep this setting default. 

 
Note 
To be able to modify the Assignment required? option, you must be an Azure AD 
Global Administrator and have an Azure AD Premium P1 or P2 license. 
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8.4 Import and Export Tools installation 

 
Important 
To perform the following procedure, you must be an Office 365 Administrator. 

 

 
Note 
This step is optional and only required if the Office 365 Store is disabled for Users. 

The tools use the new cross-platform Office JS API. Unlike the older Office COM Add-Ins, the 
add-ins do not require an installer to the user’s machine. Microsoft recommends 
managing all new application deployments via Office 365 Centralized Deployment. This 
guarantees the easiest and cleanest integration with your copy of Office, both Online 
and Desktop. 

1. Deploy the add-ins to your Microsoft 365 Admin Center: 

a. Log into the Microsoft 365 Admin Center. 

b. In the navigation menu, select Settings > Integrated Apps. 

c. At the top of the page, select Add-ins. 

d. On the Add-ins page, select Deploy Add-in > Next. 

e. On the Deploy a new add-in page, select Choose from the Store. 

f. In the search box, type OrbusInfinity Import Tool or OrbusInfinity Export Tool, and in 
the search results, select Add > Continue. 

g. Select who can have access to the add-ins and select Deploy. It’s strongly 
recommended that the person deploying the add-ins adds themselves to the list of 
users to help simplify deployment validation. The add-ins are now available to the 
users you selected 

2. Validate deployment: 

a. Open Excel or Word (either desktop or online) and start a new workbook or 
document. 

b. On the Insert tab, select My Add-ins (or Add-ins for online). 
If the installation is successful and all the requirements are met, the Add-In is now 
available under the Admin Managed section. 
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9 Solutions Hub installation 

 

Important 
To complete the below requirements, you need to be assigned administrator or 
global administrator rights in Azure AD. 

OrbusInfinity comes with a catalogue of ready-made Solutions to accelerate the 
realization of key use cases in OrbusInfinity, called Solutions Hub. The Solutions can be 
deployed into your OrbusInfinity environment by repository administrators and authors in a 
self-service manner. 

To set up access to the Solutions Hub: 

1. Go to https://hub.orbussoftware.com/<InstanceName>/ and sign in using your Microsoft 
account. 

 

Note 
Replace the <InstanceName> placeholder with your organization’s instance of 
Solutions Hub. Orbus Support will communicate the URL of your Solutions Hub 
instance during the OrbusInfinity installation. 

2. Once logged in, in the upper-right corner of the page, select your account drop-down 
and select Admin Centre. 
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3. In the navigation pane, select Tenant Management > List of Pages, and then select 
Granting Admin Consent for the Microsoft Graph Permissions. 

 
4. The page that opens provides an overview of how Solutions Hub interacts with Microsoft 

Graph and the list of the Microsoft Graph permissions required for using certain 
integration solutions with the Microsoft365 applications. Review the permissions and 
select GRANT CONSENT for each application. This will grant admin consent to the 
Solutions Hub for the specific delegated Graph permissions on behalf of all users of 
your organization.  

 
In practice, the Microsoft Graph permissions used by the Solutions Hub do not require 
admin consent. Users that will activate and run solutions can grant those permissions 
individually for most organizations. In some particular cases, certain organizations, in the 
Azure AD settings, have disabled the ability for the end users to directly grant consent for 
any Graph permissions to third-party applications. They then require an Azure AD Global 
Administrator to grant admin consent instead. In that case, the Azure AD Global 
Administrator can grant admin consent for all permissions needed to the Solutions Hub 
using this page in the Admin Centre. 


